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Welcome to the second edition of my Final Cut Pro newsletter! 

I am delighted by your interest and grateful for your comments and 
suggestions. After only one issue, this newsletter is now read around the 
world by hundreds of FCP editors. I am truly pleased and honored. Thank 
you!

The goal of this newsletter is to provide information helpful to the 
professional, high-end user of Final Cut Pro. This will publish monthly, 
around the middle of each month. Past issues will not be archived, but key 
sections will be turned into their own articles. 

Contents

●     Techniques: Using Auto-Select
●     Tip: Fun Facts about Reel Numbers
●     Client report: Problems with Chroma-key
●     Techniques: Deciding when to use Compressor (part 1)
●     Update: Brian Meaney's comments on project file size
●     Article: Archiving Your Project

Techniques: Using Auto Select

New to Version 4 Final Cut Pro is a button Apple calls, "Auto-select." It's 
located on the left side of the Timeline -- one to each track.

During normal edit operations, these buttons sit quietly and no one pays 
any attention to them. However, they become significant when you are 
cutting and pasting, or when you are applying filters. This Technique 
explains why.

Auto-select adds an additional layer of control (some would also say, 
"unnecessary complexity") when applying a filter, which I will talk about in 



a minute. However, in version 4.1, Apple changed how auto-select works 
during a copy and paste and this is what I will discuss first.

In the initial release of FCP 4 (versions 4.0 - 4.02), when you copied a clip 
to the clipboard (Edit -> Copy or Edit -> Cut) then pasted that clip back 
into the timeline, two principal rules determined the placement of the clip: 
1) the playhead determines the clip's location on the timeline and 2) the 
patch panel determines which track the clip lands on. 

With the release of FCP version 4.1, the auto-select button now controls 
which track, not the patch panel. Additionally, if you set an in or an out, the 
Paste function ignores both the in and the out, instead it pastes the clip at 
the location of the playhead. (I'm not sure if earlier versions ignored an in 
or an out, all my systems have been updated and I can't test to find out.)

Here's the new rule: When pasting a clip, the playhead determines the clip's 
location on the timeline and the track with the lowest auto select button 
selected (i.e. with a DARK center) determines on which track it appears.

Here are three examples:



In this example, all auto-select buttons are selected (dark center), so the 
pasted clip shows up on V1. V1 is the lowest numbered track who's auto-
select button is dark.

In this example, the auto-select button for V1 is NOT selected (hollow 
center), so the pasted clip shows up on V2.

In this example, the auto-select button for V1 and V3 are NOT selected 
(hollow center), so the pasted clip shows up on V2, which is the lowest 
numbered track with a dark auto-select button.

Now, there's another use of auto-select buttons, which is in all versions of 
FCP 4: use Auto-select to select a range and tracks to which a filter applies 
when you have multiple video tracks and you are also using an In and an 
Out on the Timeline. 

Here, also, are three examples:

In this example above, all auto-select buttons are dark. And I have three 
video clips stacked above each other on V1, V2 and V3.



If I select all three clips, then apply the Desaturate filter, all three clips are 
now filtered for their entire duration.

Now let's turn off the auto select button for V1. If I select all three clips, 
then apply the Desaturate filter then, again, all three clips get filtered. And, 
the filter is applied to the entire duration of all three clips.

However, if, instead of selecting the clips, I set an in and an out on the 
Timeline, this will then apply a filter to a portion of a clip or clips. At this 
point, the auto-select button becomes important.

If the auto-select button is DARK, the filter will apply to the clip, or clips, on 
that track. If the filter is hollow, the filter will ignore the clip, or clips, on 
that track. (Again, you can use In's and Out's to set a range within a clip, or 
between multiple clips.)

This can be helpful when you want to delete portions of clips on multiple 
tracks without deleting all clips at that point. Or, when you want to apply a 
filter to multiple clips at the same point in the timeline, without applying 
that filter to all clips, or to the entire duration of a clip.

Auto-select can be a very useful technique when applying filters -- on the 
other hand, if you are principally doing copy and paste, it can drive you 
nuts.

What's New on larryjordan.biz?

●     Article: Archiving Your Projects (February)
●     Fast-response FCP Support: Direct to Your Desktop (February)
●     Article: Techniques to Simplify On-Lining (January) 

http://www.larryjordan.biz/articles/lj_archive.html
http://www.larryjordan.biz/about/services.html
http://www.larryjordan.biz/articles/lj_on_line.html


[Go back to top.]

Tip: Fun Facts about Reel Numbers

Whether you use Capture Now or Log every clip, making sure you have the 
correct reel numbers, or names, assigned to your clips is essential. 
Especially if there's the possibility you will need to recapture your media 
later. (A reel number can be any combination of letters and numbers. If you 
plan to go to an EDL, keep the number short. Different EDLs support 
different length numbers, none of which is longer than eight characters.)

However, sometimes in a fit of wild exuberance, the wrong reel number 
gets assigned. Since reel numbers are stored with the actual digital media 
files on your hard drive, it is important to make sure the reel numbers are 
correct.

How can you change it? Several ways:

1.  If you need to change an existing number to something new, 
double click on the reel number in the Browser and type in the 
new number

2.  If you need to change an existing number to a different reel 
number which is already associated with a different clip in the 
Browser, control-click on the reel number and select the correct 
number from the list of all reel numbers currently used in your 
project.



3.  If you need to change a number of different clips all to the same 
reel number as other clips in the Browser, select all clips you 
want to change, and control click on the reel number of any 
selected clip. All other selected clips will have their reel numbers 
changed to the same reel number.

This makes staying organized easy.

[Go back to top.]

Client report: Chroma-keying and DV.

I was called out to a production studio client recently that was having a 
problem with one of their clients -- a producer.

Here's the situation. The producer rented their stage to shoot a green 
screen sequence using Beta SP equipment. The producer then complained 
about the quality of their cameras and lighting because he was not able to 
get a clean key from the footage. The production company wanted to know 
what the problem was and whether it was their fault.

After I got there, I learned that the producer was editing the footage in 
Final Cut Pro. However, he had dubbed the Beta SP footage to DVCAM in 
order to save money, instead of renting a Beta deck and the necessary 
capture cards and video RAIDs to allow FCP to capture the Beta footage.

I told my client that the problem began when the producer dubbed the 
footage to DV. And the reason is that while DV footage looks great, one of 
the reasons the files are so small is that the chroma information is 
significantly compressed.

In broad strokes, here's what happens. When a video picture is created, 
each pixel is defined using three numbers for each pixel -- one for the 
luminance (called the "Y" value), and two to describe the color (the "U" and 
"V" numbers). These three numbers make up what's called YUV color space.

Here's a table (using made-up numbers) that illustrates this:

Column 1 Column 2 Column 3 Column 4

Row 1
Y = 40
U = 20
V = 100

Y = 40
U = 20
V = 100

Y = 40
U = 20
V = 100

Y = 70
U = 60
V = 200

Row 2
Y = 40
U = 20
V = 100

Y = 40
U = 20
V = 100

Y = 70
U = 60
V = 200

Y = 70
U = 60
V = 200

Row 3
Y = 40
U = 20
V = 100

Y = 70
U = 60
V = 200

Y = 70
U = 60
V = 200

Y = 70
U = 60
V = 200

Here's what these colors look like visually:



This illustrates that each pixel is uniquely defined using these three YUV 
numbers. 

Let's assume this picture shows the edge between a green screen and the 
blonde hair of an actor. Given the value differences between the pixels, 
pulling a key is easy. This uncompressed format is given the short-hand 
name of 4:4:4; which means that every four pixels across are described by 
three numbers per pixel.

This is the compression format for CGI animation and some Hi-Def.

The problem is that each video picture has about 350,000 pixels (349,920 
pixels for you Beta SP purists) per frame, times 3 numbers per pixel, times 
30 frames a second, which creates a data stream of about 31.5 MILLION 
numbers per second. In other words, a lot.

So many, in fact, that a way needed to be found to reduce this amount of 
data, because it was way too much to broadcast.

The human eye is very sensitive to changes in luminance. We quickly spot 
differences between light and dark. So, the "Y" value couldn't be changed 
without seriously damaging the clarity of the picture.

However, the human eye is much less sensitive to color information. So, 
rather than describing each pixel using 3 discreet numbers, when Beta 
video was invented, it was decided to average the values of two adjacent 
"U" values and two adjacent "V" values; thus creating 4:2:2 color space. 
This instantly cut files sizes and data rates by 33%.

Here's what these revised numbers look like. The pink areas indicate which 
cells now have average values:

Column 1 Column 2 Column 3 Column 4

Row 1
Y = 40
U = 20
V = 100

Y = 40
U = 20
V = 100

Y = 40
U = 40
V = 150

Y = 70
U = 40
V = 150

Row 2
Y = 40
U = 20
V = 100

Y = 40
U = 20
V = 100

Y = 70
U = 60
V = 200

Y = 70
U = 60
V = 200

Row 3
Y = 40
U = 40
V = 150

Y = 70
U = 40
V = 150

Y = 70
U = 60
V = 200

Y = 70
U = 60
V = 200



 

Notice that here, the color values for every two pixels on the same row are 
averaged. The color is "close" to the original, but it definitely isn't the same. 
In fact, only one row accurately represents the original image. This color 
compression is given the name of 4:2:2; which means that every four 
pixels across are described by four "Y" values, two "U" values, and two "V" 
values.

This is the compression format for Beta video.

When the compression format for DV was finalized, the decision was made 
to keep cutting down the color information. So, now, instead of averaging 
color across two pixels, it was averaged across four, creating 4:1:1 color 
compression and reducing file size and data rates another 50%. This, 
combined with other compression, allowed DV footage to be about one-
seventh the size of Beta SP.

And here's the result of all this compression. The pink areas indicate which 
pixels are now using average color values, (again, remember, I am using 
made-up numbers in this illustration):

Column 1 Column 2 Column 3 Column 4

Row 1
Y = 40
U = 30
V = 125

Y = 40
U = 30
V = 125

Y = 40
U = 30
V = 125

Y = 70
U = 30
V = 125

Row 2
Y = 40
U = 40
V = 150

Y = 40
U = 40
V = 150

Y = 70
U = 40
V = 150

Y = 70
U = 40
V = 150

Row 3
Y = 40
U = 50
V = 175

Y = 70
U = 50
V = 175

Y = 70
U = 50
V = 175

Y = 70
U = 50
V = 175

 



Now, the color values of all four pixels in a row are averaged. No row 
accurately represents the original color values. This color compression 
scheme is called 4:1:1; which means that every four pixels are defined by 
four "Y" values, one "U" value and one "V" value.

This is the compression format for MiniDV, DVCAM and DVCPRO-25.

The colors in our example all seem close to the original, which to our eye is 
fine. But not to the chroma-keyer in the computer. The problem is that so 
much color information has been lost, it is impossible to precisely determine 
where the edge between green and gold is. 

When that producer dubbed his footage to DV, he seriously compromised 
his ability to get a clean key. In other words, he saved money, but spoiled 
the shot. I fixed the problem, by using FCP to key his original Beta SP 
footage, and the final results looked great.

Fast-Response Support

Many clients have asked me to develop a system to keep them up and 
running, and provide their editors with fast-response support -- especially 
when: 

●     Downtime is critical 
●     An editor has a question
●     Traffic conditions make quick response impossible
●     Or when productions are in the field.

Using new remote technology, I've developed a service where, with your 
permission, I can remotely observe your editing system and get you back 
up and running -- fast.

This service is designed for the independent producer or production 
company -- which means it is both fast and affordable. Here's a link for 
more information: www.larryjordan.biz/support.html

My other Final Cut services include: 

●     System Design
●     Installation
●     Training
●     On-going consulting
●     Editing
●     Support and Maintanence

For more information, call (818) 879-5105 -- or send an email to: 
larry@larryjordan.biz. 

[Go back to top.]

Technique: Deciding When to Use Compressor

This is the first of a two-part series on using Compressor. This month we'll 

http://www.larryjordan.biz/about/services.html
mailto:larry@larryjordan.biz?subject=%22Hey,%20Larry!%22


look at when using Compressor makes sense. Next month, we'll look at 
some of its more powerful settings and give you tips on how to use them.

Let's get the easy part out of the way first. There are four scenarios to get 
your Final Cut project to DVD:

1.  If all you want is your video burned to a DVD, use iDVD. The 
video quality is fine, the interface is essentially straight-forward 
and you won't need to use Compressor.

2.  If you will be sending your video to someone else to compress, 
simply export it from Final Cut, copy it to a Firewire drive and 
send it off.

3.  If you want to use DVD Studio Pro to create your DVD, and your 
movie is less than 30 minutes long, let DVD Studio Pro handle 
the compression. 

For these first three scenarios, export your Movie out of Final 
Cut using File -> Export -> QuickTime Movie. This provides the 
highest quality output. (There are very few reasons to export 
using QuickTime Conversion, QuickTime Movie is almost always 
better.)



If you will be compressing the movie on your computer, leave 
"Make Movie Self-Contained" UNchecked.

If you will be compressing the movie on someone else's 
computer, CHECK "Make Movie Self-Contained."

4.  If you have a long project, and you want the most control over 
how it gets compressed, then using Compressor makes a great 
deal of sense. Using Compressor also makes sense if you want 
to create versions of your project for both the Web (using MPEG-
4) and DVD (using MPEG-2).

To send your file to Compressor, go to File -> Export -> Using Compressor. 
FCP will automatically start Compressor and load your sequence into it.



Now, even though this program is called, "Compressor," this is only the 
preparatory phase to the actual compression. Here you select the quality 
and amount of compression for your video using presets. (Next month, we'll 
talk about these settings in more detail.

In general, while selecting "Fast" creates faster compressions, it also does 
not optimize quality. Since I use Compressor to create my final MPEG files, 
I always choose quality over speed. While I do tweak my settings, the 
defaults are quite good. 

To decide which setting to use, simply add the length of all your sequences 
together and make sure the compression setting you choose is greater 
than, or equal to their combined length.



Compressor will give your files a default destination - I tend to use the 
Desktop, because no two project files ever end up in the same place. 
Putting them on the Desktop makes them easy to find and move.

When you click submit, the Batch Processor sends your instructions to the 
compressor itself, while Final Cut exports your project a frame at a time. 

This status report shows you what's happening. Audio compresses very 
quickly, video takes a while -- anywhere from real-time to several times 
real-time, depending upon the speed of your system.

Compressor creates two files: am MPEG for video and an AIFF for audio. 
These are ultimately combined into a single file during the final stages of 
DVD creation. 

Larry's Teaching Schedule

If you are interested in taking one of my Final Cut courses, here are the 
training dates for February and early March, along with the Apple-Certified 
Training Center that is presenting the class.

Feb. 19-20 Intro to Final Cut Pro Santa Monica, CA DV Creators.net

http://www.dvcreators.net/


Feb. 25-27 Intro to Final Cut Pro Westwood, CA Digital Film Tree

Feb. 28 FREE FCP Overview Santa Monica, CA DV Creators.net

Mar. 4-5 DVD Studio Pro Santa Monica, CA DV Creators.net

Additional courses are posted on the home page of my website, so check 
there for the latest schedule.

[Go back to top.]

Update from last issue.

You may recall the discussion from last month about keeping your project 
file sizes small. Since then, I've had a conversation with Brian Meaney, lead 
developer for Final Cut Pro at Apple, who tells me that, "while there is no 
upper file limit to the project files in Final Cut," there were issues with FCP 
creating bloated files in versions 3 and earlier.

This problem was fixed in FCP 4, however, if you have a project that was 
created in an earlier version of FCP, then brought into FCP 4, you might 
have problems if your file sizes get too big. 

To help resolve this, keep your project files small (less than 50 MB, for 
example) and do a "Save as..." every day or two. While this may not clear 
every problem, it will help minimize them.

Article: Archiving Your Project

There's a new article on the website providing tips on how to organize your 
projects so archiving is easy when you are done.

Click here to view the article: Archiving Your Project.

[Go back to top.]

Wrap-up

Well, that's it for this edition of the newsletter. Let me know what you 
think, and if you like it, please tell your friends to subscribe. 

Coming up next month:

●     Selecting the right codec for your projects
●     Exporting audio for post-production sweetening
●     Working with settings in Compressor
●     Another "Client Report"
●     Reader feedback
●     And more.

http://www.digitalfilmtree.com/
http://www.dvcreators.net/
http://www.dvcreators.net/
http://www.larryjordan.biz/articles/lj_archive.html


Thanks -- and have fun editing!

Larry

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz. You can contact me with comments or 
suggestions for future issues at: larry@larryjordan.biz

To unsubscribe, simply send me an email and I'll drop you from the list. This list is 
not sold or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in these newsletters are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple, or any other third 
party. 

All trademarks are the property of their respective owners. 

Text copyright 2004 by Larry Jordan. All rights reserved. This newsletter may not 
be reproduced, in any way, in whole or in part, without written permission from 
the editor. 

Updated: October 24, 2004 Go to Top of Page Go To Larry's Home Page Send eMail to Larry

 

file:///Volumes/Business/Website%20-%20LJA/Larry.biz%20web%20site/nxltrs/Back%20issues/ljnxltr02.pdf
http://www.larryjordan.biz/
mailto:larry@larryjordan.biz
http://www.larryjordan.biz/index.html
mailto:larry@larryjordan.biz

	Local Disk
	Larry's FCP Newsletter - Issue 2




